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Getting	Started	
File	management	and	other	boring,	but	imperative	activities	

Shut	down	other	programs	on	your	computer.	They	slow	Premiere	down.	

*Before	you	do	anything,	ensure	ALL	of	the	files	you	are	going	to	use	for	this	project
are	saved	in	one	folder	on	your	computer.		Name	the	folder	something	that	you	can
remember.		Save	the	folder	in	a	location	that	you	can	find	later.	The	desktop	is	a
convenient	option.

**Before	you	open	Premiere,	sort	your	assets	by	file	type.	I	usually	have	a	folder	for	
audio,	b-roll,	and	photos.	Establish	a	system	that	works	for	you.		

***If	you	have	photos,	copy	them	to	another	folder	that	you	will	not	mess	with	
during	the	editing	process.		An	external	hard	drive	is	recommended.		Students	(and	
Dr.	Irlbeck)	have	frequently	made	changes	to	photos,	saved	them,	and	ended	up	
saving—and	really	messing	up—the	original	image.	

****If	you	decide	later	that	you	want	to	add	more	assets,	you	must	save	them	in	this	
folder!!	

*****The	one	exception	to	this	is	your	music.		Most	of	the	time	you	can	save	it	in	
iTunes	and	Premiere	can	access	it.	

1. Open	Adobe	Premiere.	It’s	a	purple	icon	with	Pr	on	it.
2. Click	“New	Project”
3. Name	your	project.		Make	sure	it	saves	in	the	correct	location.	Click	Browse

to	navigate	to	the	correct	folder.		Renderer:	Mercury	Playback…..;	Video:	
timecode;		Audio:	audio	samples,	
Capture:DV.		

4. Name	your	project	(at	the	top	of
the	box)	

5. Location:	Save	this	in	the	same
folder	as	the	rest	of	your	project.	

Click	ok.		You’re	in!	
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Note:		Every	Premiere	project	can	have	multiple	sequences.		It’s	best	to	do	multiple	
sequences	rather	than	multiple	projects.	An	entirely	new	project	takes	up	a	lot	of	
memory	on	your	computer.		My	suggestion	is	to	do	a	new	project	for	your	slide	
show,	and	a	new	project	or	your	final	project.		You	may	have	multiple	sequences	
within	each	project.		

Importing	Photos	and	Audio	

1. File>Import.		Navigate	to	the	folder	where	your	assets	are	stored.	Select	all	of
the	folders	and/or	files	you	need	for	your	project.	Click	OK.

You	now	have	materials	in	the	Project	Window	to	work	with.

Note:		It	is	very	easy	to	simply	drag	and	drop	files	into	Premiere,	but	Adobe’s
product	experts	say	that	the	files	work	so	much	better	when	File>Import	is
used.

If	you	don’t	see	the	folders	you	just	imported	to	go
Window>Workspaces>Editing

Setting	Up	A	Sequence	

1. If	you	placed	your	assets	into	different	folders,	you	will	see	two	folders	in
your	project	window,	and	it	will	look	like	this:

You	can	click	on	your	folders	and	they	will	open	in	a	new	(floating)	window.	
However,	those	extra	windows	are	annoying.		Here’s	how	you	fix	that.	
a. Preferences>General.	Look	at	Bins.	You	can	have	your	folders	open	in	a

new	window	(I	think	that’s	annoying),	open	in	place,	or	open	in	new	tab.
I	like	open	in	a	new	tab,	but	it’s	your	preference	here.	See	photo	on	the
next	page.

ACOM 3301 Fall 2019 2



	
	

2. Right	click	on	clip	of	video	in	the	Project	Window.		Select	New	Sequence	from	
Clip.		You	now	have	a	sequence	to	work	with.	

a. This	step	is	extremely	important	because	it	sets	up	your	sequence	at	
the	correct	frame	size.		If	you	skip	this	step,	your	entire	video	could	be	
messed	up.	

b. It	doesn’t	matter	if	you	don’t	want	to	start	your	sequence	with	this	
photo.	You	can	delete	it	later.		

	
3. Name	your	sequence	NOW.		Go	into	your	project	window	in	list	view	and	find	

the	sequence	that	you	just	started.	The	picture	below	will	help	you	figure	out	
which	thumbnail	is	a	sequence.	

4. Once	we	have	a	sequence	ready,	we	work	on	our	audio.		Open	up	your	music	
by	double	clicking	on	the	file.	The	thumbnail	will	look	like	black	squiggles.		
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5. For	today,	let’s	select	a	portion	of	the	song	to	work	with.		To	do	this,	we	have	
to	tell	the	computer	where	we	want	the	song	to	start	and	stop.			We	call	these	
start	and	stop	points	“in	and	out	points.”	

	
6. To	set	in	and	out	points,	start	by	listening	to	your	music.		Determine	where	

you	want	your	music	to	start	for	your	slide	show.		If	you’re	familiar	with	your	
music,	you	can	“scrub”	through	the	song	by	grabbing	the	playhead	
(explanation	given	in	class)	to	the	left	or	right	until	it’s	sitting	in	the	right	
spot.		To	get	very	precise	playhead	movements,	use	your	left	and	right	
arrows	to	move	it	one	frame	at	a	time.		

	
	

	
	
	
	
	
	
	
	
	
	
	

	
	
	
	
You	can	set	in	and	out	points	on	the	keyboard	or	by	clicking	the	buttons	
circled	above.	The	left	one	is	Mark	In	(start)	(keyboard	shortcut	=	I)	and	the	
right	one	is	Mark	Out	(stop)	(keyboard	shortcut	=	O).	

	
7. Once	you	are	happy	with	your	in	and	out	points	(and	you	can	play	in	point	to	

out	point	by	clicking	Option	+	K),	send	your	music	to	the	timeline	by	simply	
hitting	the	period	button	(.)	on	your	keyboard.			
	
Another	helpful	keyboard	shortcut:		The	space	bar	is	play	and	pause.	
	
We’ll	do	more	with	audio	in	next	week’s	lesson.	

	
Working	with	video	in	the	timeline	
To	maximize	playback,	change	the	size	of	the	image	previews	in	the	Program	
window.			Look	at	the	screen	shot	below—it	shows	you	which	two	things	to	adjust.		
Change	the	percentage	from	Fit	to	10	or	25%.	You	can	always	change	it	back	if	
needed.		Do	the	same	thing	to	your	program	window.	
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1. D	
	
	
	
	
	
	
	
	

	
	
	
	
	

	
	

1. Double	click	on	any	b	roll	clip.		It	will	appear	in	the	Source	window	(top	left).		
	
A	few	things	to	look	at	first.		The	time	code	(looks	sort	of	like	a	digital	clock)	in	the	
left	corner—as	you	drag	the	playhead	(blue	triangle	thing)	back	and	forth,	you	can	
see	the	timestamp	of	where	you	are	located	within	the	clip.			
	

2. Create	in	and	out	points	in	the	clip.		
	

3. We	are	almost	ready	to	send	the	clip	to	the	timeline,	but	a	few	housekeeping		
items	first.	You	must	tell	Premiere	where	in	the	timeline	you	want	the	photo	
to	go,	so	put	the	playhead		where	you	want	your	photo	to	begin	playing.		
	
Next,	we	need	to	target	which	line	we	want	the	photo	to	go	to.		On	the	left	
side	of	your	timeline,	you	see	buttons	for	Video	(V1,	V2,	V3).	and	Audio	(A1,	
A2,	A3,	A4).		You	only	want	Video	1	turned	on.		Make	sure	V1	1	is	selected	(it	
will	be	blue).		Audio	1	needs	to	be	turned	off,	so	click	it	until	it	turns	dark	
grey.	This	will	ensure	that	your	photo	does	not	disrupt	your	audio.	
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4. Now,	click	in	your	source	window,	and	hit	the	period	(.)	key.		Your	clip	should	
now	be	in	your	timeline.	
	

5. Insert	seven	more	clips	into	the	timeline.		
	

If	you	are	using	photo	files,	and	if	they	are	big	(it	will	look	like	the	program	is	really	
zoomed	in):	

	
The	program	window	may	be	zoomed	in	really	close	on	your	photo.	If	only	a	small	
portion	of	your	photo	is	visible,	your	photo	is	too	big,	and	you’ll	need	to	re-size	it.		If	
all	of	your	photos	are	too	big,	you	can	easily	re-size	them	all	at	once.	
	

1. Select	all	the	images	in	the	timeline.	You	can	do	this	by	holding	down	the	
shift	key	and	clicking	every	image.	A	faster	way	to	do	this	is	to	draw	an	
imaginary	circle	around	the	images.	Be	careful	to	NOT	include	the	audio.	

	
2. Right	click	(control	+	click	on	a	Mac)	on	any	of	the	images	you	just	selected.	

Scroll	down	to	“Set	to	Frame	Size”	and	select	it.		Magic	should	happen.	
	

3. If	you	have	large	photos	that	need	re-sized	interspersed	with	small	photos	
that	are	the	correct	size,	Command	Click	on	the	big	photos	(Control	Click	on	a	
PC).	Then	start	at	Step	2.	

	
Another	fast	way	to	re-size	images:	
	

1. 	Double	click	the	image	in	the	timeline	that	you	need	to	resize	
2. Go	to	the	Source	window	and	click	on	the	Effect	Controls	tab	at	the	top.	

	
	

ACOM 3301 Fall 2019 6



	
	
	
	
	
	
	
	
	
	
	
	
	
	
	
	

	
3. 	Click	and	drag	the	number	next	to	Scale.	Continue	dragging	until	your	image	

is	the	size	you	want.	This	works	with	any	image:	photo,	video,	or	graphic.		
	

	
Storyboard	Editing	
This	process	is	especially	helpful	when	doing	a	slide	show.	
	

1. You	can	select	all	or	some	of	your	clips	and	place	them	directly	into	your	
timeline.		In	your	project	window,	re-arrange	a	few	of	your	clips	into	an	
order	that	makes	sense.	All	you	have	to	do	is	click	and	drag	them	to	the	place	
you	want	them.	This	is	easiest	if	you	are	in	icon	mode	in	the	Project	window.		
	

2. Now,	select	them.	The	easiest	way	to	do	this	is	to	“draw”	an	imaginary	circle	
around	all	the	clips	in	your	browser.		You	know	that	it’s	right	when	each	
clip’s	icon	has	a	light	colored	border.	Circle	a	minimum	of	five	photos.		In	the	
panel	drop	down	(circled	below),	click	on	Automate	to	Sequence.	
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3. A	new	window	will	appear	that	looks	like	this:	
	
	
	
	
	
	
	
	
	
	
	
	
	
Change	the	clip	overlay	to	0	frames.		Clip	overlay	creates	a	dissolve	between	clips.	
Resist	the	urge	to	put	a	dissolve	between	all	clips.	This	will	cost	you	points	if	you	do	
so.		
	
You	now	have	a	lot	in	the	timeline	that	didn’t	take	a	lot	of	time.	HOWEVER,	all	of	
your	clips	will	be	the	same	length.		There’s	nothing	really	wrong	with	that,	but	it’s	
best	to	change	your	clips	to	the	beat	of	the	music	or	the	inflections	in	voice.			
	

a. Ripple	Edit.		Once	the	photos	are	in	the	timeline,	select	the	ripple	edit	
tool	from	the	tool	palate	(third	one	down)	
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Hover	the	ripple	edit	tool	over	the	seam	between	two	clips	in	the	timeline.	Click	and	
drag	to	the	left.	You’ll	notice	the	left	clip	gets	shorter	while	the	right	clip	gets	longer.			
This	changes	the	length	of	the	clips	without	messing	with	the	timing	of	your	entire	
project.		
	
Using	Markers	
Another	fast	way	to	storyboard	edit	is	using	markers.		I	recommend	this	if	you	really	
know	your	music.		
	

1. 	Start	with	your	music	in	your	timeline.	Go	to	the	beginning	of	your	timeline	
and	hit	play.		As	you	get	to	an	obvious	shot	change	(down	beat,	new	phrase,	
strong	change	in	music),	hit	the	M	key	on	your	keyboard.	This	will	put	little	
yellow	down	arrows	on	your	timeline.	
	

2. Do	steps	one	and	two	from	the	storyboard	editing	instructions	above.	
	

3. When	the	Automate	to	Sequence	window	appears,	click	the	dropdown	menu	
next	to	Placement.		Select	“At	Unnumbered	
Markers.”	Click	OK.		Save.	
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Dropping	directly	into	the	Program	window	
Demonstration	in	class.		A	wealth	of	options	are	available	this	way.		Simply	drag	
your	thumbnail	image	from	the	Project	window	to	the	Program	window	and	pause.	
Several	options	will	appear.			
	
Deleting	clips	from	the	timeline	
	
Let’s	say	there’s	a	clip	in	your	timeline	that	you	don’t	want	there	anymore.		In	the	
tool	palate	select	the	arrow	tool	(keyboard	shortcut	=	V).	Then	select	the	unwanted	
photo(s)	and	then	hit	delete	on	your	keyboard.			
	
It’s	likely	you	now	have	a	big	gap	between	pictures.		Hover	your	mouse	in	the	blank	
space	and	right	click	(or	control	+	click).		You	should	have	an	option	called	Ripple	
Delete.	Select	it.		Blank	space	gone.	This	does	not	usually	work	if	you	have	a	
complicated	timeline.		
	
Another	way	to	do	this	is	to	select	the	unwanted	photo(s),	then	click	the	Alt/Option	
key	and	also	click	delete.		Photo	gone,	blank	space	gone	in	one	easy	click.		
	
Helpful	Hint:		History	Panel	
Just	like	the	other	Adobe	products,	Premiere	has	a	History	panel,	although	it’s	a	bit	
hidden.	Click	the	tiny	double	left	arrow	(circled).	From	here	you	can	select	several	
different	menus,	including	History.		This	is	really	helpful	and	will	allow	you	go	to	
back	several	steps	without	hitting	Command	Z	over	and	over.		
	
	
	
	
	
	
	
	
	
	
	
	
	
	
	
	
	
	
	
	
	

ACOM 3301 Fall 2019 10



Shutting	Down	
	

1. File>Save.		You	named	the	file	when	you	started	the	project.	
	

2. Show	your	work	to	Dr.	Irlbeck.		
	

3. Quit	Premiere.		
	
	
For	today’s	lab	grade,	you	must	have	a	Premiere	Pro	project	with	the	following:	
1. 	At	least	10	assets	in	the	Project	window	
2. A	sequence	that	is	the	correct	aspect	ratio	(1080)	
3. Clips	with	audio	in	the	sequence	
4. At	least	eight	clips	of	b-roll	in	the	sequence	in	an	order	that	makes	sense.		
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ACOM	3301	
Lab	2	

	
	
Editing		Photos	in	Premiere	using	Photoshop	
You	can	edit	a	photo	right	from	your	timeline	using	Photoshop.	
	

1. Find	a	photo	in	your	timeline	(and	it	needs	to	be	in	the	timeline)	that	you	
would	like	to	adjust	(red	eye,	color,	adding	filter,	etc.)		Right	click	(control	
click	on	a	Mac)	on	the	clip	in	the	timeline	and	scroll	down	to	Edit	in	Adobe	
Photoshop	(near	the	bottom).	
	

2. Your	photo	will	automatically	open	in	Photoshop.			Make	any	changes	you	
want,	then	save.	

	
3. Go	back	to	Premiere.	The	changed	photo	should	now	be	in	your	timeline.	

	
You	may	want	to	close	Photoshop	at	this	point.		

	
Caution:		This	is	where	many	students	make	a	change	to	a	photo,	and	it	ends	up	
being	a	permanent	change.		Make	sure	you	have	a	copy	of	your	images	
somewhere	far	far	away	on	your	computer	so	that	you	don’t	destroy	your	
original.		
	
Note:		Premiere’s	editing	functions	are	becoming	so	good	that	using	Photoshop	
in	conjunction	with	Premiere	is	almost	unnecessary.	The	exception	is	red	eye.		

	
Editing	Audio	

	
Today’s	lab	will	be	easier	to	follow	with	a	music	file.		
	

1. Ensure	your	music	is	available	in	the	Project	window.			
	

2. Select	the	first	song	you	want	to	use	by	double	clicking	its	icon	in	the	media	
browser.		Your	music	should	appear	in	the	source	window.	
	

3. Make	an	in	and	out	point	anywhere	you	would	like	within	your	song.		Give	
yourself	about	60	seconds	worth	of	music	to	work	with.		

	
4. Now	overwrite	your	music	file	into	your	timeline.		Keyboard	shortcut	is	the	

period	key.	
	

5. If	you	haven’t	already,	expand	the	waveforms.	To	do	this,	hover	your	mouse	
over	the	A1	menu	items	in	the	timeline.		See	photo	for	clearer	explanation.	
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When	you	get	the	up	arrow/down	arrow	option,	drag	down.		The	track	will	
expand	and	you’ll	be	able	to	see	the	waveforms	(squiggly	audio	lines).		

	
	
	
	
	
	
	
	

6. 	
7. 	
8. 	

9. Click	the	audio	panel	at	the	top.		A	new	audio	editing	workspace	will	appear.	
	

10. Select	your	audio	in	the	timeline.	On	the	essential	sound	panel	(to	the	right)	
select	the	appropriate	box.	
	

		
	

11. 	A	new	panel	will	appear	so	that	you	can	make	adjustments	to	your	audio.		At	
this	point,	just	check	your	audio	volume.	It’s	at	the	bottom	of	the	essential	
sound	panel.	We’ll	learn	more	about	features	in	the	essential	sound	panel	in	a	
different	lesson.	
	

12. To	monitor	your	audio	and	know	that	it’s	correct,	watch	the	audio	meter	to	
the	right.	You	don’t	want	your	audio	to	get	into	the	red.		To	be	certain	that	it’s	
not	in	the	red,	change	this	setting:	

a. Right	click	on	the	audio	meter	
b. Uncheck	“show	color	gradient.”		
c. You	will	now	know	for	certain	if	your	music	is	in	the	red.	Yellow	is	

fine.		
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13. Another	easy	way	to	adjust	audio	is	with	the	Audio	Gain	menu.		Select	the	clip	

in	the	timeline,	and	press	the	letter	G	on	your	keyboard.	A	small	menu	will	
appear,	and	you	can	manually	adjust	the	volume.		Adobe	recommends	
adjusting	in	multiples	of	three.	Select	the	“Adjust	Gain	by”	option,	and	
increase	by	3.			

a. If	that	is	taking	too	long,	try	the	“Set	Gain	To.”	I	start	with	12,	then	
play	with	it	from	there.		

b. Don’t	trust	your	ears.	Watch	the	audio	meters	to	the	right.		
	

14. In	your	timeline,	hit	play.		You’ll	see	the	audio	levels	moving	in	the	meter	on	
the	right	side	of	your	timeline.		If	your	audio	is	“peaking	into	the	red”	you	
need	to	turn	it	down.			

	
Mixing	Songs	Together	
You	may	not	need	to	do	this	for	your	project,	but	you’re	going	to	learn	how	to	do	it.	
	

1. Select	a	different	portion	of	the	music	file	and	drop	it	into	the	timeline	after	
your	first	music	clip.	Let’s	blend	them	together	so	that	there	is	not	an	abrupt	
(and	unpleasant)	change	of	tune.			
	

2. Start	by	ensuring	your	audio	levels	are	the	same	for	both	songs.	There	are	
two	easy	ways	to	do	this:	
	

a. Select	both	clips	in	the	timeline.			
b. Hit	G	on	the	keyboard	
c. Click	“Set	gain	to”	and	go	with	6	to	start.	
d. Adjust	until	it’s	at	the	correct	level.	
-OR-	
e. In	the	project	window,	select	all	of	the	audio	clips	you’re	going	to	use.	
f. Repeats	B-D	above.	

	
3. The	Effects	tab	is	a	panel	on	the	right	side	of	your	Premiere	screen.	Click	on	

it.		Click	the	arrow	next	to	the	Audio	Transitions	folder.			
	

4. Click	the	arrow	next	to	the	crossfade	folder.	
	

5. You	have	three	choices:		Constant	Gain,	Constant	Power	and	Exponential	
Fade.	To	be	honest,	I	can’t	tell	the	difference	between	the	three,	so	just	pick	
one.		Then,	drag	it	on	top	of	the	place	in	your	timeline	where	your	two	songs	
meet.	Drop	it	there.	
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6. Now,	zoom	in	to	your	timeline	to	the	transition	between	your	two	songs—do	
this	by	ensuring	the	timeline	is	selected,	then	hit	the	+	sign	on	your	keyboard	
until	you	are	zoomed	in	a	significant	amount.		
	

7. Grab	the	edge	of	your	transition	(your	cursor	will	change	from	an	arrow	to	a	
red	bracket),	and	drag	to	extend	it.	This	will	make	your	transition	last	longer,	
and	will	probably	make	it	sound	a	little	better.	

	
8. Listen	with	headphones	on.		

	
9. Save.	

	
Fading	Out	
	
You	do	not	want	your	audio	to	have	an	abrupt	stop	at	the	end	of	your	sequence.		A	
fade	out	is	much	more	pleasant	for	the	viewer.			
	

1. Go	to	the	end	of	your	timeline.	
	

2. Under	the	Effects	tab,	go	to	Audio	Transitions,	Crossfade,	Exponential	Fade.	
(This	is	were	you	were	in	the	previous	section).	

	
3. Grab	the	Exponential	Fade	effect	and	drag	it	and	drop	it	at	the	very	end	of	

your	audio	on	the	timeline.	
	

4. Zoom	in	to	the	end	of	your	timeline	(the	plus	sign	zooms	in)	
	

5. Grab	the	left	side	of	the	Exponential	Fade	effect	and	drag	to	the	left	to	make	it	
longer.		For	a	more	dramatic	fade,	drag	it	so	that	the	fade	lasts	around	three	
seconds.	

	
6. Save	
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Transitions	
		
Transitions	between	photos	or	video	are	basically	the	same	as	transitioning	
between	audio.		
	

1. If	you	have	not	done	so	already,	place	at	least	five	video	clips	into	your	
timeline.		
	

2. Still	working	with	the	effects	tab	open,	go	to	the	Video	Transitions	folder.		
	

3. Now	open	the	Dissolves	folder.			
	

4. Grab	the	Cross	Dissolves	effect	and	drag	it	on	top	of	the	seam	between	your	
two	photos.	(Same	steps	as	an	audio	dissolve).		

	
5. You	can	adjust	the	length	of	your	dissolve	by	zooming	in	on	the	timeline,	and	

moving	the	effect	to	the	left	or	right.	
	

6. There	are	numerous	other	transitions	in	the	folder.		Play	around	with	two	
others.		

	
7. If	you	do	not	like	your	transition,	simply	select	it	in	the	timeline	(it	helps	to	

zoom	in)	and	hit	delete	on	your	keyboard.	
	
Another	way	to	do	transitions:	
	

8. Select	a	segment	of	your	timeline,	or	your	entire	timeline	by	drawing	an	
imaginary	circle	around	it.			
	

9. Sequence>Apply	default	transitions	to	selection.		This	will	put	a	dissolve	
between	every	photo	in	your	timeline.		Note:		I	don’t	recommend	doing	this,	
but	it’s	an	easy	way	to	accomplish	the	task	if	you	are	a	transition	lover.	

	
Blade	Tool	
A	handy	little	tool	that	makes	editing	very	easy	is	called	the	Blade	Tool.		The	blade	
tool	allows	you	to	slice	clips.		From	there	you	can	move	the	sliced	clip	around,	or	you	
can	simply	delete	it.		You	can	find	it	in	the	tool	palette.		(Keyboard	shortcut	=	C)	
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1. Select	the	Blade	tool.	It’s	right	in	the	middle	of	the	tool	palette	and	looks	like	
a	razor	blade.	
	

2. Find	a	place	in	any	clip	in	your	timeline	that	you	would	like	to	trim.		Click	on	
that	clip.		You	now	have	two	clips;	however,	if	you	were	to	play	the	video,	you	
wouldn’t	notice	anything.	

	
3. Select	one	of	the	clips	you	just	sliced.		Move	it	to	a	different	point	in	the	

timeline,	or	simply	hit	delete	on	the	keyboard.	
	

4. Save.	
	
Working	with	Multiple	Tracks	of	Audio	(including	natural	sound)	
	

1. Typically,	natural	sound	goes	on	the	A2	line	and	the	narration	goes	in	A1.	By	
default	the	audio	will	go	to	the	A1	line.	Let’s	change	where	the	audio	is	going.		
Grab	the	little	blue	square	that	say	A1	(on	the	left	of	your	timeline)	and	drag	
it	to	the	A2	line.	
	

2. Overwrite	the	file	into	the	timeline.		Your	natural	sound	will	now	go	to	A2.	
	
	

	
	
	
	
	
	
	
	
	
	
	
	
	
	
Adding	B-Roll	
	

1. Put	your	play	head	immediately	after	the	first	sentence.			
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2. Look	at	the	video	column	of	the	script.		It	tells	you	which	shot	of	b-roll	should	
match	each	sentence.		Some	sentences	have	room	for	two	shots	of	b-roll.		Set	
in	and	out	points	for	the	next	shot	designated	in	the	script.			
	

3. Re-patch	the	audio	to	the	A2	line	so	the	nats	don’t	overwrite	the	narration.		
Make	sure	the	playhead	is	in	the	spot	you	want	in	the	timeline.		Overwrite	the	
b-roll	into	the	timeline	(period	key	is	the	short	cut).	

	
4. DO	NOT	DELETE	NATURAL	SOUND!!	Adjust	the	sound	so	that	it	is	audible.		

Don’t	drown	out	the	narrator	though.		
	
A	note	about	editing:	
We	want	our	video	to	change	shots	with	the	voice	patterns	of	our	narrator.		So	when	
she	pauses,	we	should	change	our	shot.		Plus,	you	don’t	want	a	shot	to	last	much	
longer	than	four	or	five	seconds.			
	

5. Repeat	until	video	covers	all	the	narration.		
	
Helpful	Hint:	
Any	time	you	would	like	to	playback	what	you	just	edited,	hit	Shift	+	K	on	the	
keyboard.	
	

6. Go	back	and	watch/listen	to	your	timeline.		Some	of	the	nats	are	a	little	
distracting.		Go	shot	by	shot	through	the	timeline	and	adjust	the	nats,	but	
only	if	needed.	You	won’t	need	to	adjust	each	clip’s	nats.	You	can	do	this	by	
dragging	the	line	in	your	audio	file	down,	or	in	the	Source	window,	open	the	
Audio	Mixer	tab.	
	

7. Also,	the	narration	is	a	bit	too	loud.		Turn	it	down.	
	

8. Feel	free	to	add	in	some	dissolves	if	you	have	time.	
	

9. Save.	
	
Helpful	Hint:	Shift	+	Option	
Video	and	audio	go	into	the	computer	together,	generally,	they	go	onto	the	timeline	
together,	and	if	we	make	an	adjustment	to	the	length	on	the	timeline,	they	go	
together.		But	sometimes	we	need	to	adjust	the	length	of	the	video	without	messing	
with	the	audio	and	vice	versa.		Hold	down	the	shift	and	the	option	keys	(alt	if	you’re	
on	a	PC)	and	click	on	the	video	OR	the	audio.	Now	you	can	adjust	the	video	or	audio	
independently.			
	
Helpful	Hint:	Nudging	
Sometimes	the	clip	isn’t	exactly	where	we	want	it	to	sit	on	the	timeline.		It’s	easy	to	
adjust	precisely	adjust	the	location	of	the	clip.		Hold	down	the	Command	key	
(control	on	a	PC)	and	use	the	right	or	left	arrow	to	nudge	the	clip	one	frame	at	a	
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time.		Too	tedious	for	you?		Add	in	the	shift	key	to	move	the	clip	five	frames	at	a	
time.	
	
Helpful	Hint:		Trimming	
Let’s	say	your	clip	is	a	tad	too	long,	and	you	need	to	precisely	trim	it	down.		Select	
the	clip	in	the	timeline,	then	click	at	the	end	of	the	clip	so	that	the	red	bracket	
appears.	On	the	keyboard,	hold	down	the	alt/option	key	and	the	left	or	right	arrow	
to	trim	one	frame	at	a	time.	

		
	
	
	
	
	
	
	
	

	
Helpful	Hint:	Hover	Scrub	
	
	
	
	
	
	
	
	
	
	
	
	
	
	
	
	
	
Click	any	clip	ONCE	in	the	project	window.	Notice	the	yellow	line	at	the	bottom	of	
the	picture	with	a	grey	slider	bar.		Slide	it	back	and	forth	and	see	what	happens.		
This	is	very	handy	when	you’re	not	sure	of	the	video	that	each	clip	contains.		
	
For	Today’s	Lab:	
Adjust	volume	of	your	audio	
Transition	audio	between	two	clips	(you	can	delete	it	later)	
Fade	down	audio	at	the	end	of	the	timeline.		
Place	three	transitions	between	clips	
Add	three	clips	of	b	roll	into	your	timeline	and	adjust	the	nats	volume.	
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ACOM 3301 
Lab 3 

 
Zooming (AKA Scale) 

 
You can zoom in on a specific area of a photo or video, or do a general zoom to add some 
motion, interest, and/or drama to your slide show.  Just remember that you have to follow 
EVERY SINGLE STEP listed below, otherwise, it won’t work right.  This process is better with 
photos, but video works great too. The instructions below say photo, but again, it works for 
video.  

 
1.   Select a photo that you would like to have a moving zoom on, then place it into your 

timeline if you have not done so already.  If you’re doing a zoom, the photo needs to 
be a bit long…five to eight seconds would work well. 

 
2.   Double click on your image in the timeline, and it will appear in the source monitor. 

(It’s very important to do this.) 
 

3.   Place your play head over your newly placed image in the timeline. Your image should 
be visible in both the source and program monitors.  In the source monitor, click on the 
Effect Controls tab. It’s hard to see in this photo, and you may not see it on your screen, 
so press the accent/worm key to make that monitor switch to full screen.  The Effects 
tab is the left one. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

4.   You can begin your zoom at the very beginning of your photo or wait a few seconds, 
then start the zoom. I’m going to let my photo stay still for two seconds, then I’m going 
to start the zoom.  This is your decision…there’s not a right or wrong.  In the timeline, 
place your play head exactly where you want the zoom to begin. 
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5.   Under the Effect Controls tab, click the arrow next to Motion (circled above). The 

window will now look like this: 
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6.   Click the little stopwatch icon next to Position and Scale (circled). When you do this, 
it creates an in point of sorts called a key frame (circled, on the right. Looks like a 
diamond).  This tells the computer where to start the zoom. 

 
7.   Move your playhead in the timeline to the point on your photo where you want the 

zooming to stop. This may be partially through the photo, or it may be at the end. 
You pick. 

 
8.   Still working in effect controls, go to the number to the right of Scale.  Increase (if you 

want to zoom in) or Decrease (to zoom out) the number. You can click and drag if you 
want to see a preview of how it works.   

 
9.   You may need to reposition the photo.  If so, zoom out on your Program window 

(shortcut at the bottom left of the Program window). Double click the image for 
wireframes.  Click anywhere on your photo—EXCEPT on the bulls eye in the middle of 
it—and drag to reposition the photo to your liking. 

 
10.  Move your playhead to the first frame of your photo in the timeline. Watch in the 
program window.  You should have a successful zoom. 
 
11. You may need to render. (Sequence>Render In to Out.) 

 
12. Save. 

 
Note:  We can make a big picture small, a teeny picture big, rotate the photo, etc. If you 
would like to do this with your project, ask Dr. Irlbeck for some extra help.  Generally, 
rotating the photo looks silly (but not always). 

 
Opacity 
You can make anything opaque and the process is easy. We’ll do a simple opaque box for this 
lesson. 
1.  File>New>Color Matte 
2. A window will pop up to check the dimensions of your screen. Premiere knows what to do. 

Click ok. 
3. Pick your color. For this exercise, pick any shade of white. Name it white 
4. A new file named White will appear in your bin.  
5. Select your new White file and drag it and drop it on the timeline. Anywhere is fine. This is 

just practice. 
6. Double click your White clip in the timeline.  Make sure your playhead is placed over your 

white file in the timeline. 
7. In the Effect Controls tab inside the Source window, go to Opacity. It’s near the bottom of 

the list.  Over your mouse over the 100% to the right of the word Opacity. 
8. Click and drag to the left to your desired opacity.  
9. That’s just the introduction. Right below the word Opacity are an oval, a square and a pen. 

Click one.   
10. You now have a shape that you can move around. Now play around with some of the Blend 

Mode options to see what happens. This works very similar to Photoshop. 
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11. I use the Opacity tool the most when doing graphics and I need a color behind text to make 
it pop.  

 
Multiple photos on one screen 

 
To put more than one photo or videos on the screen at a time, I think it’s easiest to work at the 
end of the timeline.  You can select your photos, move them, and adjust the timing once you 
create the initial “stack” 

 
Before you get started, imagine how you want this to look on the screen: 

-two photos side by side 
-a “checkerboard” of pictures 
-a fun arrangement of several photos 

 
Also, think of the timing.  Do you want all of your photos to show up on screen at the same 
time, or do you want to add them to the screen one at a time?  Do you want the photos to be 
removed from the screen one at a time, or all at once? 

 
Generally, when you have a grouping of photos on the screen at one time, you’ll want to leave 
them up for at least five seconds, but maybe longer. That way the viewer can get a good look 
at everything on the screen. 

 
1.   If you haven’t already, make sure you have a video line for each photo that will 

be on screen. To do this, simply right click in the blank area above your top video track 
line in the timeline (See below. Right click in the circled area). 

 
2.   Select your first photo to appear on screen, then add it to timeline.  Adjust the 

length of the photo in the timeline to be on screen for the desired amount of time. 
 

3.   Make sure your photo appears in the program window by placing the playhead on top 
of it.  Double click the photo in the program window. The white keyframes will appear. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

4.   Shrink your photo and move it to a different area of the screen. 
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5.   Add your next photo to the video line on top of your first photo.  Shrink the photo and 
move it to the desired location. 

6.   Repeat until all your photos are on screen.  Re-arrange them so that they look nice.  
Adjust your start and start times in the timeline to your liking. 

 
7.   You may have to render. 

 
8.   Save. 
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ACOM 3301 
Lab 4 

Open up your project that you saved last week and start working.  
 
Text 

 
1.   There are several ways to activate the Text window. 

§ File>New>Legacy Title 
§ File>New>Photoshop File.  This option opens Photoshop with the 

correct image size and you can design from there. Feel free to work 
on your own in Photoshop. 

 
2.   A screen will pop up asking if you want to change the image size. Go with the 

default; however, you need to name your slide. By default it will be called Title 1. 
This is fine if you can remember that. Otherwise, you’re advised to name it 
something you will remember. 
 

3.   This is the Title Panel that will appear. The background image is where your 
playhead is sitting in the timeline.  

 
 
 
 
 

4.   Click the Type Tool.  It’s the capital T in the top left. Click anywhere on your ACOM 3301 Fall 2019 25



image in the Design Panel.  Type in a name or phrase, just to work with. 
 

Warning:  Do not title slides for your project that include your name or this class 
name.  It needs to be descriptive and help the viewer understand your story.  
Examples of titles that will not work and will receive a point deduction include the 
following (list is not exhaustive): 

• Your name 
• Erica’s demo video iii. 
• ACOM 3301 
• Demonstration video 
• Anything with incorrect grammar, spelling, punctuation or capitalization 

 
• You can, however, create a credits slide at the end of your project.  This can 

include your name, offer credit to the person that took the photos, etc., and it 
will count as one of the two full screen graphics you are required to have in 
this project.  

 
5.   Similar to the type tool in Photoshop, your text may be all over the place.  When 

you finish typing, click on the Arrow (top left) and move your text to the place 
you want it on the screen.  You can grab a corner of the keyframe around your 
text to resize/reshape it (only if you want). 

 
6.   Some of the pre-made Legacy Title Styles (found just below the photo in the title 

window) are pretty good. Click anywhere on the text. Click several different 
thumbnails in the Title Styles panel just to see what’s available. Choose one to 
play with today. 
 

7.   You can adjust a pre-made title style.  Under Title Properties (right side), you’ll 
see where you can change opacity, position on the screen, font, leading, kerning, 
and much, much more.  Hover your mouse over the value for Opacity (it’s 
probably set at 100% by default). You’ll notice your mouse changes to a “guns 
up” with arrows on either side of the finger. Click and drag to the left, all while 
looking at the text you just made.  This allows you to play around with changes, 
all while previewing. Or you can change the values by typing them in.  

 
Note: There is a lot more to this panel…scroll down. There are dozens of things 
you can do to your text! 

 
Change a few more things (font, stroke, shadows, etc) to make the style your own. 
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If you want your text exactly in the center of the screen, go to the Title Actions 
panel (far left panel) and center it vertically and horizontally (circled below, under 
Distribute). 
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8.   Last thing—make sure your text fits within the smallest binding box. It’s the thin 

grey square (circled). This will ensure the entire text is visible on all televisions 
and monitors. 

 
9.   If you’re really happy with what you created and want to create a new style to 

use again in other projects, it’s simple:  click the Title Styles panel menu (small 
drop down menu just above and to the right of the title styles) and choose New 
Style. Enter a descriptive name and click OK. 

 
10. Once you’re happy with your text, simply escape out of the Title screen. Premiere 

will automatically save your changes in your project files. You don’t have to save 
a separate file. 

 
11. Now look in your project window. Your slide is in there and can be placed in the 

timeline. To do so, click the icon for the slide once and then hit the comma to 
insert or the period to overwrite. Or you can drag and drop directly into the 
timeline, then adjust the length. If you click the icon twice it will open the text 
window again. 

 
Backgrounds 

 
The instructions above work fine if you want a black background; however, you probably 
want something more interesting.  You can do one of three things:  Add a solid color, put 
the text over your video, or create a textured background in Photoshop. 
 

1.   Click on the icon for the title slide you just made in the Project Manager. The Text 
window will pop up. 

 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 

 
 

 
2.   On the right side, scroll down to Background (near the bottom).  Click the box 

next to Background. Use the dropdown menu and select a gradient, or you can 
leave it solid. 

 
3.   Click the color box and select any color you like. If you want to get really 

specific, the color picker tool works great. You can also use Hex values ACOM 3301 Fall 2019 28



4.   Adjust the opacity if you want. 
 

5.   Exit out of the Text window.  Insert or overwrite your slide into your video.  

If you don’t like the background, just check the box again and it will go away. 

Place text over a photo or video.  

1.   Create a new title slide just like before. 
 

2.   Don’t mess with the background. 
 

3.   Once your title looks the way you want, simple grab it, and drag it to the Video 2 
line. You can place it anywhere that makes sense. 

 
4.   Your text should now play on top of a photo/video 

 
Many people prefer to have something a little more interesting than a solid black 
background playing behind their photos. It’s easiest to create this in Photoshop. 

 
1.  File>New>Photoshop file. 

 
2. Agree with the size it suggests. It automatically knows the dimensions of your 

video project. 
 

 3. Be creative and create a background that would be nice behind your photos. You 
can use a pre-set texture, use brushes, gradients or other creative ways to make a 
cool background. 

 
4. Once you’re finished in Photoshop, File>Save. 

 
5. Look in Premiere.  Your Photoshop file should be in the Project Manager. 

 
6. In your timeline, “turn on” Video 2 and 3.  Do this by clicking anywhere in the 

dark grey boxes. You know it’s working when it turns light grey. 
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7. Select all the photos in your timeline by drawing an imaginary circle around them. 
 

8. Drag them up a line. Most, if not all, of your clips will now be in Video 2. 
 

9. In your Project Manager, double click the background image you just made in 
Photoshop.  It should appear in the source window. 

 
10. Go back to the timeline and turn off everything BUT Video 1. 

 
11. Hit the period key.  Your background should now be on Video 1.  Grab the right 

side of it and drag it to the end of your timeline. 
 

12. You now have a backdrop behind all of your photos. It will be most evident in the 
vertical photos. 

 
SAVE. 
 
Exporting 

 

When you think you’re finished, do a Sequence>Render Entire Work area one 
more time just to be safe. 

 
1.   Watch your video one more time with the program window on full screen (hit the 

accent/worm key) and zoom your project to 100%.  Watch with headphones in! 
a.   Watch for black flashes, bad effects, typos in slides, jumpy transitions, and 

anything that may cost you points. 
b.   Listen for audio that’s too loud, unpleasant changes in audio tracks, static, 

etc. 
 

2.   When you’re sure you’re finished, save one more time. Render one more time.  
 

3.   In the project window, select your sequence.  The small icon looks like this: 
 

 
 

4.  File>Export>Media. 
 
5.  Export settings > format: H.264 preset: YouTube HD 1080p 29.97. 
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7. Rename your file, and make sure it saves where you want it.  Next to Output Name 
(a rectangle is drawn around it above) click your file name. Change it to something 
descriptive and make sure it saves in the correct location. . 

 
Make sure export audio and export video boxes are checked. Check Use Maximum 
Render Quality and Use Previews (circled). 
 
Leave everything else alone. 

 
8.  Click export.  

This will turn your project into a file which can now be uploaded to YouTube. 
 

For additional instructions or for information that may be more helpful for PC users, go to this site:  
https://helpx.adobe.com/premiere-pro/how-to/export-share-demo-reel.html .  It’s produced by 
Adobe and includes great images and a video that may be more helpful.  
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ACOM 3301 
Lab 5 

 
Start a new project and import new video files (if you have some). 
-OR, if you don’t have new video yet- 
Open your demonstration video files. File>New Sequence. Name it Practice. 

 
 
1. Place 5 clips in your timeline. They need to make some sense, but don’t spend a 

lot of time on this part.  
 

2. Select all of your clips in the timeline. Hit G to get the gain window 
 

3. Adjust your volume up or down so that you have the appropriate audio levels.  
 

Three point editing 
 
Three point editing uses a total of three in and/or out points.  You can have two in points 
and one out point, or one in point and two out points.  In and out points will be in the 
source window and the timeline. 
 

1. Open a clip from the project window.  Select an in point. 
 

2. In the timeline, find a place to insert your video (not at the end of the timeline), 
then set an in point.   
 

3. Find the place in the timeline that you want the video to stop.  Set an out point.   
 

4. Hit the period key. 
 
Television magic.  
 
Now let’s do something a little different. 
 

5. Open another clip from the project window.  Select an OUT point, but no in point. 
 

6. Select an out point in the timeline. 
 

7. Select an in point in the timeline. 
 

8. Overwrite your video into the timeline. 
 
Four Point Editing 
This is very similar to three point editing, but when you add that fourth edit point, it will 
speed up or slow down a clip to match the space you have selected. 
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1. Open a clip from the project window.  Select an in point AND an out point. 
 

2. Follow steps 2-4 from the instructions above in three point editing. 
 

3. Watch in awe at how awesome your editing skills have become.  
 

4. Save. 
 
Note:  DO NOT REPEAT SHOTS.  You will lose significant points on your final project 
if you repeat a shot.  Get in a good habit now of shooting plenty of video so that you 
don’t have to repeat anything. 
 
Masks 
Masks are a very powerful tool to use in video editing. We’ll do just one type in today’s 
lab and another in Lab 7. Today we’ll use an opacity mask to wipe tect off.  
 

1.  Place a clip in your timeline that has some movement 
 

2. Open the Type tool. It’s in your toolbar. 
 

3. Type something descriptive or useful  
 

4. Make sure you’re newly-made text is above the correct video clip in the timeline. 
Adjust the size, shape and positioning of the text so that it looks right. 
 

5. Select the title in the timeline. 
 

6. Open Effect Controls 
 

7. Put your playhead in the timeline to the exact spot where you want the text to 
dissolve away.  
 

8. Under the Opacity tool in Effect Controls, select the pen tool (also known as 
freeform Bezier tool).  Draw a shape around the object that will wipe the text 
away.  
 

9. Click the stopwatch on the mask path parameter to begin animating the mask.  
 

10. Manually move forward one frame at a time and manipulate the opacity mask 
appropriately so the mask follows the object across the screen. You can resize and 
reposition the mask as needed.  
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Auto Ducking Music 
Premiere makes it very easy to blend voice tracks or nats with music. The feature is 
called Auto Ducking. 
 

1. Place a clip of music under the timeline that you were already working in.  
 

2. Open the Essential Sound panel. 
 

3. Select your clips that have dialog OR nats in your timeline. Pick one or the other, 
not both.  

 
4. In the Essential Sound panel, select dialog (if you’re working with dialogue) or 

Ambience (if you’re working with nats).  
 

5. In Essential Sound, select Loudness, then select Auto Match to bring it up to 
broadcast standard 

 
6. Now select your music clip in the timeline, and select music in the Essential 

Sound panel.  
 

7. Again, go to Loudness, then Auto Match.  
 

8. At the bottom of the ES panel, select Ducking.  
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9. Under Duck Amount, Premiere recommends the 
Duck Amount to between -13 and -18, but it always 
depends on your sounds.  
 
10. The Fades tool is how quickly (or not) you want the 
sound to turn down.  A higher number is a longer fade 
down.  
 
11. Select “Generate Keyframes” 
 
12. In the timeline, you’ll see keyframes on your music. 
You can manipulate these in the timeline or you can go 
back into the Ducking menu and adjust from there.  

 
 
 
For today’s lab: 
Create a new sequence. 
Use three point editing. 
Use four point editing 
Mask text.  
Duck music against nats or dialogue. 
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ACOM	3301	
Lab	6	

	
Open	your	project	from	last	week.	
	
CGs	
	
The	script	indicates	the	video	needs	a	locator	CG/name	key/super,	similar	to	what	
you	would	see	on	the	news.	
	

1. Command	+	T	to	open	the	text	tool.		In	the	drop	down	menu,	go	to	Text,	and	
then	select	lower	third.	

2. This	window	will	appear:	
	

	
	

3. Give	each	CG/full	screen/title	slide	a	name	so	that	you	can	find	it	later.		Then	
click	OK.	

	
4. Play	around	with	the	text	until	you	get	a	CG/Name	key	that	you	like.		Some	

requirements	for	your	final	project	(and	part	of	today’s	activity):	
	

a. Create	a	background	color	for	your	name	key	by	using	one	of	the	
shape	tools	(circled)	
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b. 	Make	a	two	line	CG		
	

c. Change	font,	color,	size,	shadows,	alignment,	and	anything	else	to	
make	the	name	key	look	creative	and	appropriate	for	your	final	
project.		Use	the	tools	on	the	right	side	of	the	title	menu	to	easily	do	
this.		Don’t	forget	to	scroll	down	on	the	right	side	to	see	dozens	more	
options.	

	
5. There	is	no	“right”	way	to	do	this.	Play	around	with	it	until	you	have	the	text	

you	like.		Click	on	the	video	tab	at	the	top	of	the	window	to	see	what	it	will	
look	like.	

	
6. When	you	are	satisfied	with	the	look	of	your	text,	exit	the	window.		Premiere	

will	automatically	save	the	title	in	the	project	folder.		
	

7. The	text	can	be	treated	like	a	photo.		Drag	it	into	the	Video	2	line	in	an	
appropriate	location.	
	

8. Shorten	the	length	of	the	CG	just	like	you	would	shorten	the	length	of	a	photo.		
It	should	be	on	screen	for	about	five	seconds.	

	
9. If	you	don’t	like	the	placement	or	look	of	the	CG:	

	
a. Double	click	the	CG	file	in	your	Project	folder.		The	Title	window	will	

open.				
b. Make	your	changes.	
c. Notice,	as	you’re	making	changes,	the	look	of	the	CG	is	changing	in	the	

timeline.	Premiere	is	automatically	saving	and	applying	the	changes	to	
the	timeline.	
	

10. If	you	really	like	the	look	of	your	CG	and	intend	to	use	it	again,	create	a	style.		
Just	click	on	the	dropdown	menu	in	the	bottom	of	your	Title	screen	(it’s	
directly	to	the	right	of	the	Title	Styles	tab,	and	select	New	Style.		Name	it	
something	you	can	remember.		This	style	will	stay	with	Premiere	forever.	
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Motion	Graphics	
This	takes	some	getting	used	to,	but	motion	graphics	make	your	text	move	for	a	
really	neat	effect.	
	

1. 	At	the	top	of	your	Premiere	Pro	screen,	select	Graphics.	
	

2. Browse	through	the	graphics.	Select	a	title.	
	

3. Click	on	your	desired	graphic	and	drag	it	to	desired	location	the	timeline.	
Most	of	the	graphics	are	transparent,	so	you	can	drag	them	on	top	of	your	
video,	place	them	over	black,	or	create	another	slate	for	the	text	to	play	on	
top.	

a. There	are	also	some	great	options	from	Adobe	Stock.	Some	are	free	
	

4. Change	the	text	to	match	your	project.		
	

5. Adjust	the	text	as	you	wish.	You	can	change	the	font,	colors,	position…almost	
anything!	
	

6. Render.		Save.		
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Speed	Up	or	Slow	Down	Video	
	

1. Double	click	on	a	clip	that	you	want	to	speed	up	or	slow	down.			
	

2. Clip>Speed/Duration	
	

3. This	window	will	appear:	
	

	
	
	
	
	
	
	
	
	
	

4. You	can	adjust	the	duration	of	a	clip	by	changing	the	number	of	seconds,	or	
you	can	adjust	the	speed.		Lower	percentages	slow	the	clip	and	make	it	
longer.		Higher	percentages	speed	it	up	and	reduce	the	length.	Be	creative	
and	decide	what	you	want	to	do.	
	

5. Note:		This	tool	will	mess	with	your	timeline.		If	you	reduce	the	length	of	your	
clip,	you	will	need	more	video	to	take	its	place.	If	you	lengthen	a	clip,	you	
won’t	need	as	much.	

	
6. Another	fun	element	in	this	window	is	the	ability	to	reverse	the	clip.		So	if	the	

person	is	walking	forward,	you	can	make	them	walk	backward,	simply	by	
clicking	on	the	Reverse	box.		Give	it	a	try.		Keep	in	mind,	your	audio	will	also	
be	reversed.	

	
7. You	may	have	to	render.	

	
Picture	in	Picture	
	
Picture	in	Picture	is	the	same	steps	as	two	photos	on	screen	at	one	time.	
	

1. Select	a	clip	to	be	your	base	or	“big	clip.”		It	needs	to	be	in	the	Video	1	line.	
	

2. Select	your	second	clip	that	will	be	your	“little	clip.”	
	

3. Drag	the	little	clip	onto	the	Video	2	line.	At	this	time,	you	will	only	see	the	clip	
that’s	in	the	Video	2	line.	
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4. Make	sure	everything	starts	and	stops	where	you	want	it.		You	can	always	
adjust	more	later.	

	
5. In	the	Program	window,	double	click	your	video	to	turn	on	the	wireframes.	

	
6. Adjust	the	height	and	width	of	the	Video	2	clip	until	it’s	the	size	you	want.		

Hold	down	the	shift	key	in	order	to	keep	the	clip	in	proportion.	
	

7. Now	move	your	clip	to	the	place	in	the	window	that	looks	best.	
	

8. Adjust	the	Video	1	clip.	
	

9. Repeat	as	needed	if	you	want	more	than	two	shots	playing	at	once.	
	

10. All	done!	You	may	need	to	render.	
	

11. Save	
	

12. Show	your	work.	
	

	
For	today’s	lab:	
Create	a	name	key	
Create	a	motion	graphic	title	
Slow	down	or	speed	up	video	
Create	picture	in	picture	
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ACOM 3301 
Lab 7 

 
Color Correction 
 
Although shooting video correctly the first time is ideal, sometimes the color may not be quite 
right.  In these cases, you can correct.  Just know that this tool is not a miracle worker.  If your 
video is bright blue, it will probably never look that great, but the color corrector tool can help a 
little. 
 

1. Select any shot in the timeline (or add a new one) that needs a color adjustment; make 
sure the play head is on top of it. Double click the clip in the timeline. The clip should be 
visible in both the program and source monitors. Your screen will look like this: 

2. At the top of the screen, select the Color tab (circled in the photo below). The Lumetri 
Color window will appear on the right side. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
3. Premiere’s color correction options are very similar to Photoshop. There are several 

collapsible windows: Basic Correction (temperature, tint, exposure, contrast, saturation); 
Creative (adjust the tints, shadows, and hi-lights); Curves (adjust RGB curves); Color 
Wheels (very cool way to tone down a strong color tone); Vignette (extremely easy way 
to add some shading around the corners of your screen). 
 

4. The easiest way to learn how to use these tools is to experiment. Try several and see what 
happens.  Dr. Irlbeck’s favorites are the color wheels, vignettes, and basic correction.  
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5. To make sure your corrections will be eye appealing on most screens, go to your source 
window and click on Lumetri Scopes.  Under the Curves panel to the right, adjust the 
curves so that it does not go below zero nor above 230. 

 
To duplicate: 
You corrected the color of an interview, and you’re going to use a sound bite from the same 
source later in your timeline. You don’t want to go through the color correction steps again. 
 

6. Right click the color corrected clip in the timeline. Select Copy. 
 

7. Go to the clip that needs to be corrected in the timeline. Select it, then right click. Select 
“Paste Attributes.” All the effects you had on the first clip will be applied to the second. 
 

8. That’s all! You may have to render.  Save to be safe. 
 
 
Video Filters 
 
You can do all sorts of crazy/fun stuff with a video filter.  This is one of those “just because you 
can, doesn’t mean you should” kind of things. 
 

1. In the Project window, click on the Effects tab.   
 

2. Now, click on the Video Effects folder. 
 

3. There are a number of things you can do.  Pick one that sounds fun, and simply click and 
drag it on top of any clip you want to put a filter on. 

 
4. You can adjust the look of the filter by going into the Source Monitor and clicking on the 

Effect Controls tab.  There are all sorts of changes you can make there. 
 

5. Try another effect or two to see what they do. 
 

Audio Effects 
 
You can do some fun effects to your audio, and even make it sound better. 
 

1. Go back to the effects tab in the Project Window. 
 

2. Click the Audio Effects folder. EQ really helps with a soft spoken individual like the 
gentleman in the interview. Reverb is kind of fun, but only if you want to sound like 
you’re in an auditorium. Flanger is a fun effect also. 

 
3. Just click on the filter and drag it on top of the audio clip you want to adjust.  You can 

make further changes under the Effect Controls tab. 
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4. You will probably have to render. 
 

5. Save. 
 
An easy way to boost audio: 
 

1. Select a clip that has really low audio. 
 

2. Clip>Audio Options>Audio Gain. 
 

3. Adjust the gain by 15.  See what happens. Re-adjust as needed.  Command+Z repeatedly 
if you don’t like it. 
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